
Computing Progression Map  

Year 
group 

                      Key skills and knowledge 
Computer Science 

Key 
vocabulary 

Links to Faith and 
Values 

 

 

 
Year 1 

-Understand what algorithms are; how they are implemented as programs on digital 

devices; and that programs execute by following precise and unambiguous instructions 

-Create and debug simple programs. 

Create a series of instructions and plan a journey for a programmable toy 

• Know and understand that algorithms are sets of instructions 

• Know that an output is the result of an input, e.g. the Bee Bot moved because 

the direction button was pressed 

• Know that algorithms are implemented as programs on digital devices 

• Know that instructions require sequential and precise inputs to achieve a given 

goal 

• Know how to debug (find errors) in given instructions 

• Know how to create a simple program e.g. a sequence of instructions for a Bee 

Bot to perform given tasks, or control an on screen sprite 

Device 

Control 

Input 

Output 

Direction 

Algorithm 

Instruction 

Sequence 

Sprite 

Commands 

When using programmable toy to 

plan a journey this could be done on 

a grid planning the journey from 

Medina to Mecca (Link with Hajj) 

Use questioning to link key 

terminology with faith (e.g. Where 

are Allah’s algorithms/instructions for 

how to be a Muslim found? – in the 

Quran). 

 

 
 

 
Year 2 

-Understand what algorithms are; how they are implemented as programs on digital 

devices; and that programs execute by following precise and unambiguous instructions 

-Create and debug simple programs. 

-Use logical reasoning to predict the behaviour of simple programs. 

Understand that algorithms are used on digital devices 

Write a simple program and test it 

Predict what the outcome of a simple program will be (logical reasoning). 

Understand that programs require precise instructions 

• Know how to write clear and precise algorithms for every day tasks 

• Know how to make predictions using logical reasoning for given algorithms 

• Know how to implement simple algorithms on digital devices e.g. Bee Bot, Blue 

Bot, Daisy the Dinosaur App, Scratch Jr App 

• Know how to decompose algorithms into small chunks to find errors and debug 

programs 

• Know how to use logical reasoning to predict the outcome of simple programs 

• Know how to improve and change a sequence of commands using a trial and error 

approach 

Precise  

Logical 

Reasoning 

Digital devices 

Decompose 

Predict 

Logical reasoning 

Trial and error 

Sequence/sequential 

Use questioning to link key 

terminology with faith (e.g. Are the 

algorithms for how to be a muslim 

precise? – talk about how there are 

specific instructions for how to pray, 

how to fast, how to do hajj) 

 

Children could write the algorithm for 

how to pray as an extension to other 

algorithms (E.g. how to make a 

sandwich, how to play tag).  

 

Give children the algorithm for 

prayer with an error in it. Children to 

decompose the algorithm into 

smaller chunks to debug/find the 

error and correct it.  

 

Year 3 

-Design, write and debug programs that accomplish specific goals, including controlling or 

simulating physical systems; solve problems by decomposing them into smaller parts 

-use sequence, selection and repetition in programs; work with variables and various forms 

of input and output 

-use logical reasoning to explain how simple algorithms work and to detect and correct 

errors in algorithms and programs 

Write programs that accomplish specific goals 

Navigate 

Sprite 

Foreground 

Background 

Coordinates 

Commands 

Network 

Use questioning to link key 

terminology with faith (e.g. If we are 

the sprits of this world, what is the 

background? Who inputs the 

commands? What is our network?). 

Use this to reflect on the power and 

magnificence of Allah.  

 

 

 

 



 Design a sequence of instructions, including directional instructions 

• Know how to navigate the Scratch programming environment 

• Know how to create and alter a sprite and background 

• Know how to work with various forms of input to control the sprite (mouse/keys) 

• Know how to change the position of the sprite by using x and y coordinates 

• Know how to design and create programs that accomplish specific goals in Scratch 

(e.g. draw a shape) 

• Know how to decompose tasks into smaller, separate steps to create an algorithm 

• Know how to use repetition in programs by identifying patterns 

• Know how to improve and change a sequence of commands using a trial and error 

approach 

-understand computer networks including the internet; how they can provide multiple 

services, such as the world wide web 

Understand what computer networks do and how they provide multiple services 

• Know that digital devices accept inputs, create outputs by following a process 

• Know how to classify inputs, processes and outputs 

• Know the similarities and differences between digital and analogue tools 

• Know that computers in school are connected in a network 

• Know why computers are networked 

• Know the difference between the Internet and the World Wide Web (WWW) 

Position Children could use Scratch to 

programme an Islamic themed game 

(e.g. dress the muslim for Hajj, race to 

the ka’ba, Islamic quiz).  

 

 
 

 

 
 
 

Year 4 

-Design, write and debug programs that accomplish specific goals, including controlling or 

simulating physical systems; solve problems by decomposing them into smaller parts 

-use sequence, selection and repetition in programs; work with variables and various forms 

of input and output 

-use logical reasoning to explain how simple algorithms work and to detect and correct 

errors in algorithms and programs 

Give an ‘on-screen’ sprite specific instructions that take them from A to B 

Experiment with variables to control sprites 

Make an accurate prediction and explain why they believe something will happen 

• Know how to write increasingly more precise algorithms for use when programming 

– using repetition 

• Know how to use simple selection using conditional statements ‘If, Then, Else’ in 

programs to make a decision 

• Know how to use a range of outputs (visual/audio) 

• Know how to use logical reasoning to systematically detect and correct errors in 

programs 

-understand computer networks including the internet; how they can provide multiple 

services, such as the world wide web 

Understand how information can be shared online 

• Know that servers on the internet are located across the planet 

• Know how networks are physically connected 

• Know what can be shared using the internet 

• Know how websites can be shared on the world wide web 

• Understand how email is sent across the internet in packets 

 

 

 

Precise 

Repetition 

Selection 

Conditional 

Statements 

Visual/audio 

Servers 

Email 

Internet 

Physical 

Incorporate faith linked audio and 

visual into programming (e.g. 

adhaan, quran, nasheeds) to tell a 

story with an Islamic moral (note: it 

is not permissible to represent a 

prophet as a sprite in some 

denominations so avoid children 

telling story of the prophet on 

programming software).  

 

Use questioning to link key 

terminology with faith (e.g. what 

conditional instructions are there in 

Islam? – encourage children to use 

the conditional statements if, then, 

else)  

 

Discuss: Does the internet help to 

keep the ummah united (as we are 

instructed in the quran for example 

in 3:103 and 49:10 as well as many 

others)? 



Year 5 

-Design, write and debug programs that accomplish specific goals, including controlling or 

simulating physical systems; solve problems by decomposing them into smaller parts 

-use sequence, selection and repetition in programs; work with variables and various forms 

of input and output 

-use logical reasoning to explain how simple algorithms work and to detect and correct 

errors in algorithms and programs 

Use technology to control an external device 

Develop a program that has specific variables 

Combine sequences of instructions and procedures to turn devices on and off 

• Know how to design and create a game platform incorporating skills learnt 

• Know how to evaluate their own work, and that of peers, identifying errors. 

• Know how to use variables within programs e.g. timers and score counters using 

conditional statements e.g. if the timer reaches 0, the game ends 

• Know how to create programs that control or simulate physical systems (crumble 

boards/Lego Mindstorms) 

• Know how to evaluate, and debug algorithms 

-understand computer networks including the internet; how they can provide multiple 

services, such as the world wide web 

-appreciate how search results are selected and ranked 

Understand how search results are selected and ranked 

Identify and know examples of physical computer systems 

• Know how we view web pages on the internet 

• Know how pages are ranked in a search engine and that the quality of results 

can vary 

• Know and name a range of computer networks and how these connect people e.g. 

social media, internet, intranet and cloud services 

• Know that computers can be connected together to form systems 

• Know and recognise the role of computer systems in our lives 

Know how information is transferred over the internet 

Variables 

Timers 

Counters 

Conditionals 
Simulate Evaluate 

Social media Intranet 
Cloud services 
External Platform 

Encourage children to create games that 
have an Islamic link as a way of creating 
a programme for a specific audience. It 
could be an Islamic sprite, background or 
link to them (e.g. dress the muslim for 
Hajj, race to the ka’ba, Islamic quiz). 

 
Discuss: Do you think the prophet would 
have liked the internet/social media? 
Why? What would he have used it for 
(note the children have previously 
discussed: Does the internet help to keep 
the ummah united (as we are instructed 

in the quran for example in 3:103 and 
49:10 as well as many others)? 



 
 

 

 

 
Year 6 

-Design, write and debug programs that accomplish specific goals, including controlling or 

simulating physical systems; solve problems by decomposing them into smaller parts 

-use sequence, selection and repetition in programs; work with variables and various forms 

of input and output 

-use logical reasoning to explain how simple algorithms work and to detect and correct 

errors in algorithms and programs 

Write a program that combines repetition, selection and variables 

Write generic code that can be used across multiple projects 

• Know how to use a range of sequence, selection and repetition commands, 

combined with variables to implement game designs 

• Know how to broadcast messages 

• Know how to write generic code for use across multiple projects 

• Know how to critically evaluate projects, suggesting improvements 

• Know how to decompose code into sections for effective debugging 

-understand computer networks including the internet; how they can provide multiple 

services, such as the world wide web 

-appreciate how search results are selected and ranked 

Be aware that some search engines may provide misleading information 

• Know how to effectively use a search engine, 

• Know that to ensure information is valid and accurate, cross referencing of 

different sources is necessary 

• Know and understand the need to critically evaluate information 

Broadcast messages 

Generic code 

Critically evaluate 

HTML 

Sources 

Cross reference 

Critically evaluate 

Children could critically evaluate a 
programme created showing people how 
to pray/do hajj commenting on its 
accuracy and suggesting improvements 
as well as debugging any errors.  
 

Discuss: if broadcast messaging were an 
option at the time of the prophet what 
message do you think would have been 
broadcast? Do you think this would have 
altered how Islam spread? How? 
 
Teaching children how to use main search 

engines as well as search engines on 
Islamic websites (e.g. https://www.al-
islam.org/)  and how to ensure that the 
Islamic information is valid and accurate 
by cross referencing and checking the 

sources.  

https://www.al-islam.org/
https://www.al-islam.org/


 
 

Year 

group 

 
Key skills and knowledge 

Digital Literacy 

Key 

vocabulary 

SHINE & Links to 

faith 

 

 

 
 
 

Year 1 

-Recognise common uses of information technology beyond school 

Talk about some of the IT uses in their own home 

• Know a range of uses for information technology beyond school, e.g. a library 

-use technology safely and respectfully, keeping personal information private; identify 

where to go for help and support when they have concerns about content or contact on 

the internet or other online technologies 

Use technology safely 

Keep personal information private 

Use a website safely 

• Know, discuss and understand the individual elements of SMART rules acronym: 

Safe, Meet, Accepting, Reliable, Tell 

• Know that there are people online who could make you feel sad, embarrassed or 

upset, and give examples of when and how to speak to a trusted adult 

• Know how to use the internet, with adult support, to communicate with known 

people and use key words in search engines 

• Know that information posted online can be copied, and begin to know what 

personal information should be kept offline 

• Know and explain that work created digitally belongs to them; it’s their idea, or 

has their name on 

• Know how to safely log out of websites and equipment when tasks are finished 

SMART rules 

Safe, Meet, 

Accepting, Tell 

Information 

technology 

Online 

Trusted adult 

Internet 

Offline 

Digitally 

Log out 

Safer Internet Day 

 

 

 

 

 

Year 2 

-Recognise common uses of information technology beyond school 

Know how technology is used in school and outside of school 

• Know more ways in which information technology is used beyond school, e.g. how 

a supermarket works 

• Know how technology can be connected and help people 

• Know that the internet is a source of information e.g. books, newspapers, tv 

programmes 

• Know which devices at home are connected to the internet 

-use technology safely and respectfully, keeping personal information private; identify 

where to go for help and support when they have concerns about content or contact on 

the internet or other online technologies 

Source of 

information 

Connected 

Appropriate 

Permission 

Identity 

Search engine 

Safer Internet Day 

 

Discuss questions linking 

content to faith, such as: 

- How do you think the 

prophet Muhammad 

would have used 

technology? 

-  Do you think that 

technology helps to 

connect the ummah?  

- Is the internet a good 

source of Islamic 

information? 



 Know where to go for help if concerned. 

• Know that some websites are more child friendly and appropriate than others 

• Know which search engines are acceptable to use to stay safe 

• Know which websites are safe to use in school, and at home, with permission 

• Know how people’s identity online can be different to their identity in real life, 

and what these differences could be 

• Know examples of ways to communicate online 

• Know examples of bullying behaviour, and what this might look like online, and 

what can be done about this 

• Know and explain rules and guidance for using technology 

• Know how to report unsafe things online 

  

 
 

 

 
 

Year 3 

-use technology safely ,respectfully and responsibly; recognise acceptable / unacceptable 

behaviour; identify a range of ways to report concerns about content and contact 

-be discerning in evaluating digital content 

Use technology respectfully and responsibly 

Know different ways they can get help if concerned 

• Know what is meant by the term identity, how you can represent yourself online 

and ways in which you can change your identity e.g. using an avatar 

• Know and understand the term digital footprint, being able to give positive and 

negative examples 

• Know the need to be careful before sharing things online, and the consequences 

of this 

• Know and understand the term privacy settings, and how these can be applied 

• Know simple strategies for creating and keeping passwords private, and why they 

are important 

• Know that websites/games implement age restrictions to keep users safe 

• Know different examples of technology specific forms of communication e.g. emojis, 

text speech 

• Know and explain the risks of communicating online with people you don’t know 

well 

• Know the difference between knowing someone online, and knowing someone in 

real life 

• Know what bullying is, and explain how this may happen online, explaining 

strategies to stop this from happening 

Digital footprint 

Privacy settings 

Devices 

Implement 

Technology specific 

Emoji 

Strategies 

Safer Internet Day 

 

Link content with faith by 

discussing questions, such 

as: 

- How do you represent 

your Islamic identity 

online?  

- Should I share where 

I go to mosque or 

what quran class I go 

to online? 

-  

 
 

 
Year 4 

-use technology safely ,respectfully and responsibly; recognise acceptable / unacceptable 

behaviour; identify a range of ways to report concerns about content and contact 

-be discerning in evaluating digital content 

Recognise acceptable and unacceptable behaviour using technology 

• Know how online identities can be different to real life identities 

• Know the importance of reflecting on their online behaviour, and the impact this 

can have on their digital footprint, thinking carefully about how content posted 

online might affect how others feel about them (their reputation) 

• Know and understand that the same friendship values apply online as to face to 

face 

• Know strategies for safe and fun experiences in a range of online social 

environments, giving examples of how to be respectful to others online. 

• Know a range of online technologies where bullying might take place, and the 

ways in which this might happen 

• Know that some information on the internet is protected by copyright, consider who 

has the right to use it, with examples 

Reputation 

Online social 

environments 

Online technologies 

Reliable 

Accurate 

Copyright 

Opinion 

Belief 

Fact 

Password 

Passcode 

Safer Internet Day 

 

Link content with faith by 

discussing questions, such 

as: 

- If someone says they 

are a muslim, does 

that mean they are 

safe to talk to/meet? 

(link to how online 

identities are 

sometimes different to 

real life and being 

safe on the internet).  

- Does technology 



• Know that not all sources of information on the internet are reliable/ accurate, 

knowing the difference between opinion, belief and fact 

• Know how technology can distract from other things, identifying times or situations 

where limiting the amount of time of technology might be of use, and strategies 

to support this 

• Know what a strong password is, and explain strategies for keeping personal 

information private in a range of contexts 

distract you from 

faith? What strategies 

could you use to help 

you stop it distracting 

you from your faith? 

How could you ensure 

you pray on time even 

if you have 

technology? 

 

Talk about common 

passwords in the Islamic 

community and whether it 

is safe to use these well 

known numbers (E.g. 

786110). 

 

 

 

 
 

 

 
 

 
Year 5 

-use technology safely ,respectfully and responsibly; recognise acceptable / unacceptable 

behaviour; identify a range of ways to report concerns about content and contact 

-be discerning in evaluating digital content 

-understand the opportunities they (computer networks, incl. internet) offer for 

communication and collaboration 

Understand that children have to make choices when using technology and that not 

everything is true and/or safe 

• Know and explain how online identities can be copied, modified or altered 

• Know, and be familiar with scenarios associated with online risk and danger, and 

what to do about them 

• Know that all online activity can be traced 

• Know how to make positive contributions to online communities, giving examples 

• Know when someone is upset, hurt or angry online, and know strategies to support 

• Know how to block and report abusive content/users on a range of platforms 

• Know and describe helpline services that are there to support , and how they can 

be contacted e.g. Childline 

• Know the difference between online mis-information (accidental) and dis- 

information (deliberate) 

• Know what it means to be sceptical, and understand the term hoax 

• Know that not all information found online is honest, accurate or legal, and can 

explain why and how this might happen 

• Know ways in which technology can affect sleep and describe some of the issues, 

knowing strategies, tips or advice to overcome these, to promote healthy sleep 

• Know how to create and use strong and secure passwords 

• Know and explain how many free apps or services may read and share private 

information from devices 

• Know when it is acceptable to use the work of others, giving examples 

• Know how to work collaboratively to create a blog 

Modified 

Scenario 

Risk/danger 

Online communities 

Traced 

Positive contributions 

Platforms 

Abusive 

content/users 

Mis-information 

Dis-information 

Sceptical 

Hoax 

Blog 

Collaboratively 

Safer Internet Day 

 

Link content with faith by 

discussing questions, such 

as: 

- How do you think the 

prophet would have 

used an online 

community to make a 

positive 

impact/contribution? 

 

 



 
 

Year 6 

-use technology safely ,respectfully and responsibly; recognise acceptable / unacceptable 

behaviour; identify a range of ways to report concerns about content and contact 

-be discerning in evaluating digital content 

-understand the opportunities they (computer networks, incl. internet) offer for 

communication and collaboration 

Be increasingly aware of the potential dangers in using aspects of IT and know when to 

alert someone if feeling uncomfortable 

• Know that not all online information can be trusted 

• Know how to check and identify the reliability of websites 

• Know and understand different ways to collaborate on projects online 

• Know and understand the need to critically evaluate information found online 

• Know how and why some people may present opinions as facts, being able to 

define the terms ‘influence’, ‘manipulation’ and ‘persuasion’, and how these might 

be encountered online (advertising, ad targeting) 

• Know how to identify, and flag inappropriate content 

• Know and be aware of the terms: plagiarism, copyright and data protection in 

relation to their own work 

• Know and be able to describe issues online that might make others feel sad, 

worried, uncomfortable, or frightened, giving examples of ways to help both online 

and offline 

• Know why you should keep asking for help until you get the help you need 

• Know how impulsive content and communication online may cause problems 

• Know ways to support others online, demonstrating ways of reporting problems, 

understanding responsibilities for the well being of others 

• Know how to capture bullying content as evidence (screen grabs, profile links) 

• Know how to develop an online reputation which will allow others to form a 

positive opinion 

• Know, assess and action different strategies to limit the impact of technology on 

health (nightshift mode, regular breaks, correct posture, sleep, diet and exercise) 

and explain the importance of self-regulation of the use of technology, with 

strategies 

• Know to use different passwords for a range of online services, and know what to 

do if passwords are lost or stolen 

• Know and explain simple ways to increase privacy on apps, and explain ways in 

which some online content targets people to gain money or information, describing 

strategies to help identify content 

• Work collaboratively to create a piece of work (Google docs/Teams/Vlog) 

Reliability 

Collaborate 

Vlog 

Critically evaluate 

Influence 

Manipulation 

Persuasion 

Inappropriate content 

Plagiarism 

Copyright 

Data protection 

Impulsive content 

Screen grabs  

Self regulation 

Health and Well Being 

Safer Internet Day 

 

When talking about sources of 

information discuss double 

checking and critically 

evaluating Islamic sources of 

information to help you know it 

is reliable and accurate to what 

you believe. You may wish to 

also discuss why people may 

present their opinions as facts 

about Islam.  

 

Linking how plagiarism is wrong 

with the values of our school 

(e.g. integrity, respect, 

excellence) as well as the 

virtues of God that we should 

try to eminate and are taught in 

the quran (E.g. Al-Haqq – The 

truth; Quranic verse 2:43) 

 

Discuss: Why does your online 

reputation matter? Do your 

actions online influence the 

ummah? Do your actions online 

influence how others view 

Islam? 

 

Talk about common 

passwords in the Islamic 

community and whether it 

is safe to use these well 

known numbers (E.g. 

786110). 

 



 
 

 
 

Year 

group 

 
Key skills and knowledge 

Information Technology 
 

Key 

vocabulary 

SHINE & Links to 

faith 

 

 
 

 
Year 1 

Use technology purposefully to create, organise, store, manipulate and retrieve digital 

content 

Record sound and video and play back using an ipad 

Create, store and retrieve digital content 

• Know how to safely turn on and off a laptop, computer or other device. 

• Know the different parts of a computer/laptop e.g mouse, keyboard 

• Know where numbers, letters and symbols are located on the keyboard (use of 

Shift key for symbols). 

• Know and input username and password to log onto the device (laptop/computer). 

• Know the use of the Enter key. 

• Know how to locate a specific program (Word, PowerPoint, Internet). 

• Know how to save a document into the correct folder on the server. 

• Know how to open a saved document. 

• Use at least 2 different types of software to present information, e.g. a booklet 

using ‘Book Creator’ app on ipad, inserting images from camera roll and text. 

Curser 

Mouse 

Keys 

Keyboard 

Upper/lower case 

Username 

Password 

Program 

Word processor 

Document 

File 

Save 

Retrieve 

Health and Wellbeing – 

learning about ways technology 

can be used to communicate 

with people we don’t live with. 

 

 

 

 
 

Year 2 

Use technology purposefully to create, organise, store, manipulate and retrieve digital 

content 

Organise, retrieve and manipulate digital content 

• Know how and when to use caps lock vs shift key for capital letters. 

• Know how to locate the ‘Home’ Tab in Microsoft Office programs. 

• Know how to change the size, font and colour of text. 

• Know how to copy and paste images from the internet. 

• Know how to insert images from a file. 

• Know how to insert a text box. 

• Know how to input information/data to achieve an output – pictogram, bar chart, 

table. 

• Use at least two different types of software to present information. 

Tab 

Insert 

Font 

Text box 

Output 

Data 

Copy 

Paste 

Data 

 

Year 3 
Select, use and combine a variety of software (including internet services) on a range of 

digital devices to design and create a range of programs, systems and content that 

Layout 

Orientation 

Portrait 

 



 accomplish given goals, including collecting, analysing, evaluating and presenting data 

and information 

Discern when it is best to use technology and where it adds little or no value 

Use a range of software for similar purposes 

Collect and present information 

• Know how to use the ‘Layout’ tab in Microsoft Word to change the orientation of a 

document. 

• Know how to add, remove and format a slide in Microsoft PowerPoint. 

• Know how to insert pictures alongside text. 

• Know how to manipulate pictures using the ‘Format’ tab to rotate, bring forwards 

and backwards. 

• Know how to copy and paste texts and images 

• Know how to evaluate own and peers work by commenting on its effectiveness 

against given criteria. 

• Know how to input information to create a chosen output – e.g. graph, and insert 

to a document. 

• Use at least two different types of software to present information. 

• Know that information can be imported and exported via external drives e.g. USB 

Use search technologies effectively 

Navigate the web to complete simple searches 

• Know that the internet contains fact, fiction and opinions, and how this can 

affect their reliability. 

• Know a range of safe search options. 

• Know that URL (Uniform Resource Locator) stands for the address of a world wide 

web page 

• Know how to reach a desired web page. 

Landscape 

Format 

Rotate 

Manipulate 

Evaluate 

Effectiveness 

Imported 

Exported 

USB 

Input 

Output 

URL 

Reliability 

When presenting information it could 

be around a topic you have learnt 

about in R.E. or a topic that is 

relevant to the time in the Islamic 

Calendar (e.g. Ramadhan, Hajj) or 

an Islamic Story.  

 
 

 

 
Year 4 

Select, use and combine a variety of software (including internet services) on a range of 

digital devices to design and create a range of programs, systems and content that 

accomplish given goals, including collecting, analysing, evaluating and presenting data 

and information 

Select and use software to accomplish given goals, e.g. produce and upload a podcast, 

create a PowerPoint and export as a video 

• Know and understand how and why ‘Transitions’ are used when combining multiple 

slides in a PowerPoint presentation. 

• Know where to locate the ‘Transitions’ menu in Microsoft PowerPoint. 

• Know how to choose an appropriate transition for purpose and effect. 

• Know and understand how and why ‘Animations’ are used to manipulate text and 

images within a slide presentation. 

• Know where to locate the ‘Animations’ menu in Microsoft PowerPoint. 

• Know how to choose an appropriate animation for purpose and effect. 

• Know how to evaluate, edit and improve own, peers and published work by 

commenting on its effectiveness against given criteria. 

• Use at least two different types of software to present information. 

Transitions 

Animations 

Appropriate 

Published 

Edit 

Improve 

Manipulate 

Talk about when the Prophet shared 

the Quran with others, why they 

were in awe of it. In today’s time 

what would people be in awe off? 

How do you think the prophet may 

have presented the religion if he 

lived today? 

 

When presenting information it could 

be around a topic you have learnt 

about in R.E. or a topic that is 

relevant to the time in the Islamic 

Calendar (e.g. Ramadhan, Hajj) or 

an Islamic Story. 

 
Year 5 

Select, use and combine a variety of software (including internet services) on a range of 

digital devices to design and create a range of programs, systems and content that 

accomplish given goals, including collecting, analysing, evaluating and presenting data 

and information 

Analyse and evaluate information reaching a conclusion that helps with future projects 

Know how to work collaboratively on digital projects 
• Know how to choose which presentation program/app would best meet the needs of 

Presentation 

Diverse 

Green screen 

Collaboratively 

Blog 

Column 

Row 

When presenting information it could 

be around a topic you have learnt 

about in R.E. or a topic that is relevant 

to the time in the Islamic Calendar 

(e.g. Ramadhan, Hajj) or an Islamic 



the project. 

• Know how to create more diverse projects e.g. using green screen and animation. 

• Know how to upload a video/image from one location to another. 
• Know how to work collaboratively to create a blog, sharing information and 

personal views. 

• Know the difference between a column and a row in a spreadsheet, and 

understand these are made up of cells. 

• Know how to identify and write within a cell 
• Know how to input data by inserting into columns and cells 
• Know how to highlight specific cells to be used to create a chart/graph 
• Know where the ‘Insert’ – ‘Charts’ menu is located and how to create the most 

appropriate chart/graph. 

• Use at least two different types of software to present information. 

Use search technologies effectively 

Understand that not all search results are reliable 
Know that search results vary in reliability, and to be objective when reviewing results. 
 

Cell 

Highlight Menu 
Story. 

Year 6 

Select, use and combine a variety of software (including internet services) on a range of 

digital devices to design and create a range of programs, systems and content that 

accomplish given goals, including collecting, analysing, evaluating and presenting data 

and information 

Present data collected in a variety of ways that makes it easy for others to understand 

• Know how to add: music, hyperlinks and use slideshow tab edit timings to create 

powerful presentations. 

• Choose the most appropriate software for given tasks, with justification. 

• Know what HTML (Hypertext Markup Language) is and recognise HTML tags 

• Know how to create a webpage using HTML 

• Work collaboratively to create a piece of work (Google docs/Teams) 

• Use at least two different types of software to present information. 

Hyperlink 

Software 

Justification 

Vlog 

HTML 

WW2 PowerPoint 

 

Ensure any ‘music’ added to PowerPoints 
is either sound effects, nasheeds, quran 
or voice clips.  

 
 


